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WinImage is a shareware from an ASP member. You can copy it, distribute it, it is available on BBS or 
CDROM. But if you use it, do not forget to register!



What is a disk image  ?

WinImage is a disk image management utility. A disk image is a file which contains all the floppy data (file,
FATs, boot sector, directory...).

By making an image of a floppy disk and writing it on another, we get an exact copy (as with the Dos 
DiskCopy command). We can read a floppy and write the image on the hard disk. The day after, without 
using a floppy, we can extract a file from the image. The week after, we can write the image on two new 
floppies, for instance, without needing the original, and create two exact copies of it.

We can also create disk images with WinImage. If we want to put 5 files (taking 1.3 Mb) on a 3"1/2 HD 
unformatted floppy, we create an empty 1.44 Mb image, inject the 5 files into it from the hard disk (this is 
very fast) and, in one operation, we format the floppy and write the image on it.

WinImage can format and use very large-capacity non-standard disks. (3"1/2 HD 1.72 Mb and 5"1/4 HD 
1.44 Mb). To use them, you must load, before Windows 3.1, the TSR FdRead, a shareware from 
Christoph H. Hochstätter which you can get with the FdFormat utility. I think that having a look at it is a 
must. You don't need this TSR if you use only standard formats with WinImage.

You can load an image by reading a floppy, or reading an image file, or creating an empty image.

You can extract the files of an image onto any device. (hard disk, network unit or... floppy).

You can also add files to the image.
The image can be copied onto a floppy (which must have the same format) or saved in a file.

An image file contains all the floppy sectors. If it's not full, you can truncate it.

WinImage can read the images of a lot of disk copy utilities: Wimage (in FdFormat utility) from C.H. 
Hochstätter, CopyVit from Sébastien Chatard, DrDos 6 and OS/2 2.x diskimage utilities, DCF (Disk Copy 
Fast) from Chang Ping Lee, DF (Disk Image File Utility) from Mark Vitt, Super-DiskCopy from Super 
Software, SabDu from S.A. Berman, Disk-RW from K. Hartnegg, DiskDupe from Micro System Design, 
internal disk Microsoft and Lotus image utilities and the MFMT sample Windows NT application that 
comes with Windows NT SDK.



Using WinImage

WinImage shows in its main window the files and directories present in the image. You can go into a 
directory by double-clicking on it. To return to the parent directory, double-click on the first entry ("..").

WinImage runs with the image in memory. When there is no image, some icons and menu entries are 
grayed.

You can create a directory, delete or add files in the image with the icons or the Image menu. You can use
drag-and-drop from the Windows File manager to WinImage to inject data into an image, or from 
WinImage to another application to extract from it.

You can extract files in three ways: By extracting in the Image menu (or its icon), launching a file by 
double-clicking on it, and dragging it to another application.

WinImage allows you to drag the image file from WinImage to another application: You put the mouse 
pointer in the status bar or in the toolbar background. You press the left mouse button and keep it 
pressed, put the mouse pointer onto another application (drag and drop client), and release the mouse 
button. This original function allows you to add the image in a .ZIP or .ARJ file with Nico Mak's WinZip 
utility, or attach the image to an e-mail created with Microsoft™ MS-Mail, or Lotus™ Notes or ccMail.

I am distributing the utility FDREAD.EXE, from C. Hochstatter, with the Intel version of WinImage. 
FDREAD is used for reading non-standard floppy disks while in DOS and Windows 3.1. FDREAD is not 
needed for WinImage operation under Windows 3.1. FDREAD has no effect under Windows 95 or 
Windows NT.

I suggest that you do not use the 820 KB or 1.72 MB formats, because they can not be read under 
Windows NT. I suggest that you use the DMF or the 1.68 MB format.

DMF and 1.68 MB format are the same physical format. (80 track, 21 sector/track). 1.68 MB format has 
224 entries in the root directory, and a cluster size is 512 bytes. DMF format has 16 entries in the root 
directory, and a cluster size is 1024 or 2048 bytes. Microsoft use DMF for the floppy version of some of 
their new software. Windows 95 and Windows NT 3.5x read and write directly in DMF format, and you will
need FDREAD under to read these files in MSDOS or Windows 3.1.

Some Microsoft DMF floppy disks contain information to make them write-protected under Windows 95 or
Windows NT 3.5x. To write on these floppy disks, you will need to reformat them.



File Menu

New

Creates a new, empty image. You must select a format (by example 1.44  Mb).

Open

Opens an image file.

Close image

Closes the current image.

Save

Saves the current image.

Save as

Saves the current image with a new name.

Batch Assistant

Open Batch assistant dialog box.

Exit

To quit WinImage.



Image Menu

Create directory

Creates a directory in the current image.

Select

Selects files in the current image.

Inject

Injects files into the current image.

Extract

Extracts files from the current image.
If no file is selected, WinImage extracts all files from the image. Otherwise it extracts only selected files.
Depending on the Confirmation option, you will have to specify the extraction path. (a dialog box with 
some Preference fields is shown).

Delete file

Deletes files from the current image, after asking for confirmation.
If there is no file selected, WinImage deletes all the files from the image, otherwise it deletes only the 
selected files.

Change Label

Changes the volume label of the current image.

Change size

Changes the size of the current image.
The new size must be greater than total size of the files in the image. (You can transform a 1.44Mo image
into a 360Ko image only if you have less than 360Ko of files).

Defrag current image

Defragments the current image files.





Diskette Menu

Use drive A: or B:

Use drive A: or B: to read and write floppies.

On a computer with two drives, this command lets you choose the unit you want to use for reading or 
writing disks.

Read disk

Read a floppy and store its image in memory.

Compare disk

Compares current image with a floppy.

Write disk

Writes current image to a floppy.

Format and write disk

Formats a floppy and writes the current image onto it.



Option Menu

Sort by Name
 Sort by Type
 Sort by Size
 Sort by Date

These options are used for displaying the file present in the image.

Font
Changes the current font (used for displaying the files present in the image).

Preference
Set WinImage Options

You see this dialog box:

Ignore unused track when reading  : if this option is checked, when reading (or comparing) a floppy which 
isn't full, WinImage ignores the unused tracks.

Ignore unused track when writing  : if this option is checked, when writing to floppy an image which isn't 
full WinImage ignores the unused tracks.

Verify writing  : if this option is checked, WinImage verifies when writing to a floppy. That takes more time, 
but you are sure the new disk is readable.



Use only standard format  : if this option is checked, WinImage create only standard floppies (which don't 
need FDREAD).

Select floppy for image  : if this option is checked, WinImage selects a floppy type for the image in 
memory. (If you load a 360Ko image, WinImage selects a 5"1/2 floppy format).

Truncate unused image part  : if this option is checked, WinImage reduces the size of the image when 
writing an image file which isn't full.

Use incremented open/save wizard: if this option is checked, WinImage increments the filename by 1: 
After opening (or saving) the "DISK01.IMA" file, WinImage proposes "DISK02.IMA" for the next opening 
(or saving).

Path  : You specify here where from to get the files to form the image.

These three options are for extracting subdirectories (when directories are in selection when extracting, or
if there is no selection)  :

Ignore subdirectories  : WinImage won't extract the subdirectory(~es) selected.

Extract all in the same directory: WinImage extracts files in a subdirectory of the image in the Path 
location.

Extract with pathname: WinImage extracts files from a subdirectory of the image to a subdirectory of the 
Path location.

Default viewer: defines viewer application launched when double-clicking on a file without association.

Confirmation



Inject: The 2 first options allow you to enable/disable the use of a dialog box when injecting files. The last 
is for ask confirmation when you replace

Extract: The three first options control the display of a confirmation dialog box when extracting files.

Confirm overwriting when extract: if this option is checked, if extracting risks overwriting a file, WinImage 
asks for confirmation.

When deletes files: this option controls the display of a confirmation dialog box when deleting files on 
image.

Options for registered user: see Registering.

Verify disk content before write  : if this option is checked, WinImage asks for confirmation before writing 
on a disk which contains data.

Sound and notification
Select sound and message

With this option, you can ask WinImage to play sound (beep or, with a sound adapter, .WAV, .MID and, 
under Windows NT, .AVI file).



Batch assistant

With the batch assistant, you can chain operation on several image. By calling "Batch assistant" in file 
menu, you see:

When WinImage execute batch, it repeat the sequence : make an image in memory (source) and use this
image for saving (destination). When the source has no image, the batch is complete.

You must select one source between:
- Set of floppies : WinImage will read some floppies. You say how many floppies you want read.
- Set of images files : WinImage will load some image. You can open a list file (.WIL), or add some 
image.
- Directory injecting : WinImage will inject directories on image. If the directory name contain number, it
can increment the directory name, and make an image for each directory. If a directory is bigger than 
an image, WinImage make several image

You must select one, or more, destination:
- Set of floppies : WinImage will write some floppies. You say if you want format them.
- Set of images files : WinImage will write some image. You specify the filename of the first, and 
WinImage increment filename. You can optionnaly make a list file (.WIL) with a comment.
- file extraction : WinImage will extract file from image to directories you specifiy. It can increment the 
directory name.

In this sample, WinImage extract file image DISK1.IMA to DISK5.IMA on directories c:\temp\disk1 to c:\
temp\disk5.



Evolution of WinImage

September 1995 : Version 2.2
- Support for Win32s for 32 bits Intel version under Windows 3.1x
- Format blank disk without creating a new image
- Fix bug to format and write DMF under Windows 95 and Windows NT 3.5x

June 1995: Version 2.10
- Windows 95 compatibility
- Support of Microsoft DMF - 1.68 Mb floppy

January 1994: Version 2.00
- Batch assistant
- Show disk directory when reading
- WinImage can be iconised when read or write a floppy
- New toolbar
- Image information
- Title bar
- Sound notification
- Support for .DLL resource (for other language than french or english)

September 1993: Version 1.11
Support of directory drag from Windows File Manager.

September 1993: Version 1.10
main differences:
-  Windows  NT version: built for the released version of NT, drag and drop server run correctly.
-  Functions for deleting files in an image, changing format and defragmenting.
-  Drag server of image file.
-  Better usability: new menu, news option and confirmation dialog boxes, "Always on top" in system 
menu, last 4  files in File menu, help on toolbar via button.
-  Incremented filename.
-  Better support of comparing and option saving.

May 1993  : Version 1.0
First version.

Somes users asked for compression support and for an option to add comments to an image. I will 
consider these requests, along with a better integration with the Windows 95 (and next Windows NT) shell
in the next major release.

There are two versions of WinImage: a 16 bit version for Windows 3.1 and a 32 bit version for Windows 
NT (WINIMANT.EXE). Background reading or writing disks using WINIMANT.EXE will ABSOLUTELY NOT
degrade application performance under Windows NT or Windows 95 (with the exception of operations 
with the DMF format under Windows 95).

There are Intel 80x86, MIPS, R4000 and Dec Alpha versions of WinImage NT. PowerPC version is 
planned.



WinImage exists in English, French, German and Spanish versions. If you would like to provide 
translations of WinImage or the documentation in another language, please contact me.

WINIMANT.EXE (the Win32 version of WinImage) use WIM16T95.DLL and WIM32T95.DLL under 
Windows 95, and WIM1632S.DLL under Windows 3.1x + Win32s. The file HLR20A16.EXE, distributed in 
some beta releases, is no longer used.

The next version of WinImage will be available only in Win32, support for Windows 3.1 will be provided 
only through Win32s.

I hope you will send me a feedback about WinImage. My CompuServe ID is 100144,2636 and my Internet
e-mail box is 100144.2636@compuserve.com.

If you find WinImage useful, give it to your friend and upload it to your BBS.
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Where find WinImage

You can find the last version of WinImage :
- on Compuserve, forum WUGNET (librarie disk/disk util), and WinShare (librarie disk/disk util and utility 
NT)
- on ftp.cica.indiana.edu, Simtel (oak.oakland.edu) and mirror ftp site.

You can find these file : (xx is the version number, by sample WINIMA20.ZIP is a ZIP for version 2.0) :
- WINIMAxx.ZIP : Help and both executable for Windows NT Intel and Windows 3.1
- WIMANTxx.ZIP : Help and executable for Windows NT Intel-Windows 95, english only
- WIMAXPxx.ZIP : Help and executable for Windows NT Dec Alpha
- WIMAMPxx.ZIP : Help and executable for Windows NT Mips R4000
- WIMAPPxx.ZIP : Help and executable for Windows NT PowerPC



Registering

WinImage is shareware. You can copy, distribute and try it and it is available on BBS or CDROM. If you 
use it, you must register. You will receive a license, a registration code and the latest release.

If you register WinImage, I send you a registering number. You can choose Registering in the Option 
menu, and enter this code. After, you can in the Preference (Option menu) ask to hide the first screen.

The licence price is still 100  french francs or $20.00 until end 1995.It'll be 150 french francs or $30 in 
1996.

send a check (french francs or US$)    to  :

Gilles Vollant
13, rue François Mansart
91540 Mennecy
France

Phone  : (33) (1) 64 99 75 23

Site Licence : You can contact WindowShare B.P. 2075 / 57051 Metz cedex 2 France, Fax : (33) 87 32 37
75 

You can use the CompuServe shareware registration service (GO SWREG). The WinImage registration 
number is 1233.

Credit Card Ordering:
To order by MasterCard, Visa, American Express, or Discover, call the Public (software) Library at 1-800-
2424-PsL or 1-713-524-6394 or send your order by FAX to 1-713-524-6398 (U.S.A. phone number) or by 
CompuServe Email to 71355,470. You can also mail credit card orders to PsL at P.O. Box 35705, 
Houston, TX 77235-5705. You need provide cardholder's name exactly as it appears on the customer's 
credit card plus the billing adress for the card. PsL's office hours are 7:00 am to 6:00 pm CST Monday-
Thursday and 7:00 am to 12:30 pm CST Fridays. You can give your internet adress if you have.
The WinImage number on the PsL registration service is #10976.

Use these numbers only for Credit Card orders. For site licenses or WinImage information, contact me at 
CompuServe 100144,2636.

This software is produced by a member of the Association of Shareware Professionals (ASP). ASP wants 
to make sure that the shareware principle works for you. If you are unable to resolve a shareware-related 
problem with an ASP member by contacting the member directly, ASP may be able to help. The ASP 
Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536.

Japanese customer can contact P&A Shareware Co, Ltd., of Japan 302 Bellwins, 1367-23, Nakagami, 



Akishima, Tokyo, 196, Japan Phone: 0425-46-9141 / Fax: 0425-46-9142 
(internet:PAF02461@niftyserve.or.jp).




